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Lab 8
Curve Sketching

Objectives

1. To use the computer as a tool in sketching curves.
2. To distinguish the important characteristics of a curve.

Curve sketching (even with the help of a computer) can be difficult.  For example, over
what interval should you plot a function to observe all its interesting characteristics?  No
plotting program will simply give you the best interval.  However, you can use a plotting
program to gain insight into the behavior of the function; and, with some mathematical
analysis, you can obtain a graph of the function showing its most interesting characteris-
tics.  TEMATH provides the following tools to help you find the important characteris-
tics of the graph of a function.

Intercepts

To find an x-intercept (root or zero) of a function, click the Single Root Finder  tool 

and click in the Graph window near the x-intercept.  The value of the x-intercept will be
written into the Report window.

To find the y-intercept of a function, following these instructions: click the Rectangular
Tracker tool , click in the Domain & Range window to make it active, enter 0 into

the x-cell in the bottom portion of the window and press the Enter key or click the
Enter button.  The value of the y-intercept will be written into the y-cell in the bottom
portion of the Domain & Range window and the Rectangular Tracker's dot will be
positioned at the y-intercept in the Graph window.

Symmetry

To check if a function is an even function (symmetric about the y-axis), select
Reflections — y-axis from the Tools menu. If the graph is its own reflection, then it is
symmetric about the y-axis (at least on the plotted domain).  To check if a function is an
odd function (symmetric about the origin), select Reflections — origin from the Tools
menu.  If the graph is its own reflection, then it is symmetric about the origin (at least on
the plotted domain).

Asymptotes

If Adaptive Plot in the Graph menu is checked, TEMATH will display the vertical
asymptotes of the plotted function in the Graph window and it will write the values of
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the vertical asymptotes into the Report window.  To find horizontal and slant (oblique)
asymptotes, select Other Asymptotes from the Tools menu.

Local Maximum and Minimum Values

To find local maximum and minimum values, click the Maximum/Minimum Finder
tool  and click in the Graph window near the local maximum or minimum.  The
value and the coordinate location of the local maximum or minimum will be written into
the Report window.

Concavity and Points of Inflection

Use the Rectangular Tracker tool  to approximate the points of inflection and the
intervals over which the graph of the function is concave up or concave down.

Printing a Graph

To print a copy of a graph, click in the Graph window to make it active and select Print
Graph from the File menu.

Exploration 1 Curve Sketching Problems

The purpose of this exploration is for you to gain some experience in examining the
properties of a graph, for example, by looking at a graph you should be able to estimate
where the graph is increasing or decreasing, where it is concave up or concave down,
where it has a local maximum or minimum, and so on.  It is also important that you try
different plotting domains when graphing the functions in this exploration so that you
don't miss any of the important features of the graph.  Your goal is to obtain a complete
graph of each function, that is, a graph that shows all the important features of the graph
and the plotted portion of the graph suggests what the entire graph would look like if it
were plotted over its entire domain.

In the following problems: select an appropriate domain that will give a complete graph,
fill-in all the information that is requested about the graph, and    attach to this lab a
printed copy of the complete graph for each of the following functions   .  Note: some
points of inflection may be difficult to see (try using TEMATH 's Zoom tool).  Be sure to
think about what the concavity of a function must be when approaching an asymptote.
Also, be sure to use     parentheses    when necessary for entering functions into TEMATH.

1. Plot the function f (x) =
2x3 − 2x2 + 3

x3 + 1
.  The TEMATH expression for this function is

(2x^3–2x^2+3)/(x^3+1).

Domain of f (x) . . . . . . . . . . . . . . . . . . . . . . . . . . . .Range of f (x). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Are there any points in the domain where f (x) is not differentiable?  If so, what are

they?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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x-intercepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . y-intercept .. . . . . . . . . . . . . . . . . . . . .

Symmetry.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Asymptotes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Intervals of increase or decrease .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Local maximum and minimum values .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate values of the points of inflection.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate intervals over which f (x) is concave up or concave down... . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2. Plot the function f (x) =
2x3 + 3x2 −10x + 24

x 2 + 4
.  The TEMATH expression for this

function is (2x^3+3x^2–10x+24)/(x^2+4).

Domain of f (x) . . . . . . . . . . . . . . . . . . . . . . . . . . . .Range of f (x). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Are there any points in the domain where f (x) is not differentiable?  If so, what are

they?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

x-intercepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . y-intercept .. . . . . . . . . . . . . . . . . . . . .

Symmetry.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Asymptotes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Intervals of increase or decrease .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Local maximum and minimum values .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate values of the points of inflection.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate intervals over which f (x) is concave up or concave down... . . . . . . . . . . . . . . . . .
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3. Plot the function f (x) =
1 − x 2

x
.  The TEMATH expression for this function is

sqrt(1–x^2)/x.

Domain of f (x) . . . . . . . . . . . . . . . . . . . . . . . . . . . .Range of f (x). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Are there any points in the domain where f (x) is not differentiable?  If so, what are

they?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

x-intercepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . y-intercept .. . . . . . . . . . . . . . . . . . . . .

Symmetry.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Asymptotes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Intervals of increase or decrease .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Local maximum and minimum values .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate values of the points of inflection.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate intervals over which f (x) is concave up or concave down... . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

4. Plot the function f (x) = (x + 1)2 / 3 (x − 2)1 / 3 .  The TEMATH expression for this function

is rad(3, (x + 1)^2) rad(3, x – 2).

Domain of f (x) . . . . . . . . . . . . . . . . . . . . . . . . . . . .Range of f (x). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Are there any points in the domain where f (x) is not differentiable?  If so, what are

they?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

x-intercepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . y-intercept .. . . . . . . . . . . . . . . . . . . . .

Symmetry.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Asymptotes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Intervals of increase or decrease .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Local maximum and minimum values .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate values of the points of inflection.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate intervals over which f (x) is concave up or concave down... . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

5. Plot the function f (x) =
x

x2 +1
.  The TEMATH expression for this function is

x/sqrt(x^2+1).

Domain of f (x) . . . . . . . . . . . . . . . . . . . . . . . . . . . .Range of f (x). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Are there any points in the domain where f (x) is not differentiable?  If so, what are

they?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

x-intercepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . y-intercept .. . . . . . . . . . . . . . . . . . . . .

Symmetry.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Asymptotes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Intervals of increase or decrease .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Local maximum and minimum values .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate values of the points of inflection.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Approximate intervals over which f (x) is concave up or concave down... . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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6. Plot the function f (x) = x/(x − 2) .  The TEMATH expression for this function is

sqrt(x/(x–2).

Domain of f (x) . . . . . . . . . . . . . . . . . . . . . . . . . . . .Range of f (x). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Are there any points in the domain where f (x) is not differentiable?  If so, what are

they?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

x-intercepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . y-intercept .. . . . . . . . . . . . . . . . . . . . .

Symmetry.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Asymptotes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Intervals of increase or decrease .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Local maximum and minimum values .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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